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Technical Support
Symantec Technical Support maintains support centers globally. Technical Support’s
primary role is to respond to specific queries about product features and functionality.
The Technical Support group also creates content for our online Knowledge Base.
The Technical Support group works collaboratively with the other functional areas
within Symantec to answer your questions in a timely fashion. For example, the
Technical Support group works with Product Engineering and Symantec Security
Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount
of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at
the following URL:

www.symantec.com/business/support/index.jsp

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/contact_techsupp_static.jsp

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be at
the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information
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■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals
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Support agreement resources
If you want to contact us regarding an existing support agreement, please contact
the support agreement administration team for your region as follows:

customercare_apj@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

Documentation
Product guides are available on the media in PDF format. Make sure that you are
using the current version of the documentation. The document version appears on
page 2 of each guide. The latest product documentation is available on the Symantec
website.

https://sort.symantec.com/documents

Your feedback on product documentation is important to us. Send suggestions for
improvements and reports on errors or omissions. Include the title and document
version (located on the second page), and chapter and section titles of the text on
which you are reporting. Send feedback to:

doc_feedback@symantec.com

For information regarding the latest HOWTO articles, documentation updates, or
to ask a question regarding product documentation, visit the Storage and Clustering
Documentation forum on Symantec Connect.

https://www-secure.symantec.com/connect/storage-management/
forums/storage-and-clustering-documentation

About Symantec Connect
Symantec Connect is the peer-to-peer technical community site for Symantec’s
enterprise customers. Participants can connect and share information with other
product users, including creating forum posts, articles, videos, downloads, blogs
and suggesting ideas, as well as interact with Symantec product teams and
Technical Support. Content is rated by the community, and members receive reward
points for their contributions.

http://www.symantec.com/connect/storage-management
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Introducing the agent for
SAP Web Application
Server

This chapter includes the following topics:

■ About the Cluster Server agent for SAP Web Application Server

■ What’s new in this release

■ Supported software

■ How the agent makes SAP Web Application Server highly available

■ Agent functions

■ Typical SAP Web Application Server configuration in a VCS cluster

■ Setting up SAP Web Application Server in a VCS cluster

About the Cluster Server agent for SAP Web
Application Server

The Cluster Server agents monitor specific resources within an enterprise
application, determine the status of these resources, and start or stop them according
to external events.

The Cluster Server agent for SAPWeb Application Server provides high availability
for SAP NetWeaver 7.1, 7.3, and 7.4 in a cluster. The agent is designed to support
a wide range of SAP NetWeaver environments which include SAP NetWeaver 7.1,
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7.3, and 7.4; SAP NetWeaver CE 7.1 and 7.3; SAP NetWeaver Mobile 7.1 and 7.3;
and SAP NetWeaver PI 7.1 and 7.3.

The Cluster Server agent for SAP Web Application Server brings SAP instances
online, monitors the instances, and takes the instances offline. The agent monitors
the system processes and server states, and can shut down the server in case of
a failover.

The agent supports the following SAP instance types:

■ Central Services Instance

■ Application Server Instance

■ Enqueue Replication Server Instance

The agent supports the following SAP Web Application Server Usage Types:

■ ABAP

■ Java

■ Add-In (ABAP + Java)

What’s new in this release
The enhancement in this release of the agent for SAP Web Application Server is
as follows:

■ Added support for SAP NetWeaver 7.4

Supported software
For information on the software versions that the Cluster Server agent for SAPWeb
Application Server supports, see the Symantec Operations Readiness Tools (SORT)
site: https://sort.veritas.com/agents.

How the agentmakes SAPWebApplicationServer
highly available

The Cluster Server agent for SAP Web Application Server continuously monitors
the SAP instance processes to verify that they function properly.

The agent provides the following levels of application monitoring:

■ Primary or Basic monitoring

11Introducing the agent for SAP Web Application Server
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This mode has Process check and Health check monitoring options. With the
default Process check option, the agent verifies that the SAP instance processes
are present in the process table. Process check cannot detect whether processes
are in the hung or stopped states.

■ Secondary or Detail monitoring
In this mode, the agent runs a utility to verify the status of the SAP instance.
The agent detects application failure if the monitoring routine reports an improper
function of the SAP instance processes. When this application failure occurs,
the SAP instance service group fails over to another node in the cluster.
Thus, the agent ensures high availability for SAP instances.

Agent functions

Online
The online function performs the following tasks:

■ Validates the values of the agent attributes required to bring the SAP instance
online.

■ Performs a preliminary check to ensure that the SAP instance is not running
already on the specified node in the cluster.

■ Starts the SAP Windows service SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■ Starts the SAP instance using the startsap.exe utility.

■ Ensures that the instance is initialized successfully.

Offline
The offline function performs the following tasks:

■ Validates the values of the agent attributes required to bring the SAP instance
offline.

■ Performs a preliminary check to ensure that the SAP instance is not already
offline.

■ Stops the SAP instance using the stopsap.exe utility.

■ Stops the SAP Windows service. SAPSID_InstID, where InstID is the last two
characters of the InstName attribute.

■ Kills any remaining SAP instance processes to ensure that the instance
processes are removed completely.

12Introducing the agent for SAP Web Application Server
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Monitor
The monitor function performs the following tasks:

■ Validates the values of the agent attributes required to monitor the SAP instance.

■ Performs a first-level monitor check as follows:

■ The function verifies that the SAP Windows service SAPSAPSID_InstID is
running, where InstID is the last two characters of the InstName attribute.

■ Verifies that all processes that the ProcMon attribute lists are running.

■ If the value of SecondLevelMonitor attribute is greater than 0, themonitor function
performs a more thorough check of the SAP instance as follows:

■ For APPSERV instances, the function uses the following utilities to perform
this check:

SAP utility usedServer type

sapcontrol.exeSAPWeb Application
Server as ABAP

sapcontrol.exeSAPWeb Application
Server as Java

sapcontrol.exeSAPWeb Application
Server as Add-In

■ For an Enqueue or Enqueue Replication server instance, the function uses
the ensmon.exe utility.

■ If the MonitorProgram attribute specifies a custommonitor program, the monitor
function executes the specified program.
See “Executing a custom monitor program” on page 55.

Clean
■ Uses SAP’s sapsrvkill.exe utility to stop all processes of the particular SAP

instance.

■ Stops SAPSAPSID_InstID, the SAP Windows service for the instance.

■ The clean function identifies and kills any remaining SAP instance processes
using the unique combination of the SAPSID attribute and InstID, that is the last
two characters of the InstName attribute. All these processes must also belong
to the SAPServiceSAPSID or sapsidadm user.

13Introducing the agent for SAP Web Application Server
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Typical SAPWebApplication Server configuration
in a VCS cluster

A typical SAP Web Application Server configuration in a VCS cluster has the
following characteristics:

■ VCS is installed and configured in a two-node cluster.

■ The SAP Web Application Server instance binaries are installed locally on both
nodes or on shared disks.

■ The Cluster Server agent for SAP Web Application Server is installed on the
both nodes.

■ The drive:\usr\sap directory is shared with name sapmnt and saploc.

Figure 1-1 depicts a configuration where SAP Web Application Server
instance binaries and SYS are installed completely on shared
disks.

Public Network

Shared disks / diskgroups

VCS Private Network

SAP instance binaries and
SYS on shared disks

Node 1
Node 2
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Figure 1-2 depicts a configuration where SAP Web Application Server
instance binaries are installed locally on each node and SYS is
installed on shared disks.

Public Network

Shared disks / diskgroups

VCS Private Network
Node 1 Node 2

SAP instance binaries

SAP instance binaries

SYS on shared disks

Setting up SAP Web Application Server in a VCS
cluster

Follow the steps below to set up SAP Web Application Server in a cluster:

■ Set up a VCS cluster.
For more information on installing and configuring Cluster Server, refer to the
Cluster Server installation and configuration guides.
Refer to the Storage Foundation and High Availability Solutions Configuration
and Upgrade Guide for more information on installing and configuring Cluster
Server.

■ Install and configure SAP Web Application Server for High Availability.

■ Install the Cluster Server agent for SAP Web Application Server.

Note: The Cluster Server agent for SAPWeb Application Server is automatically
installed during the installation of the VCS server components.
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■ Configure the service groups for SAP Web Application Server.
See “About configuring service groups for SAP Web Application Server”
on page 57.
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Installing and configuring
the SAP Web Application
Server for high availability

This chapter includes the following topics:

■ About SAP Web Application Server

■ Uniquely identifying SAP Web Application Server server instances

■ Monitoring an SAP instance

■ About installing SAP Web Application Server for high availability

■ About configuring SAP Web Application Server for high availability

■ Setting up SAP systems for clustering

■ Installing SAP system using Virtual Hostname

■ Configuring the agent for message server restart

■ Configuring the Enqueue Replication Server

■ Clustering an SAP instance

■ Configuring the SAP systems on Windows Server 2008/2012

About SAP Web Application Server
All SAP NetWeaver components (example, PI, CE) run on top of the SAP Web
Application Server.

2Chapter



The following three usage types are possible with SAP Web Application Server:

■ SAP WebAS ABAP (ABAP only)

■ SAP WebAS Java (Java only)

■ SAP WebAS Add-In (ABAP and Java)

Depending on the SAP NetWeaver component to be installed, the Web Application
Server installation type is determined. For example, SAP NetWeaver PI requires
SAP WebAS Add-In (ABAP + Java) usage type.

SAP system components
An SAP application instance hasmultiple services or components which are typically
deployed across multiple servers.

SAP identifies the following services as critical to the application environment,
representing potential single points of failure:

■ Database Instance

■ Central Services Instance (SCSxx or ASCSxx)

■ Enqueue Replication Server (ERSxx)

■ Network File System (NFS) or Common Internet File System (CIFS) services

■ Solution Manager Diagnostics Agent (SMDAxx)

Where xx takes the value of an SAP Instance number ranging from 00 to 99.

SAP architecture
Table 2-1 lists the different SAP architectures and its components.

Table 2-1 SAP architecture

FunctionsServiceComponentArchitecture

■ Controls program that manages the
resources of the R/3 applications.

■ Balances assignment of the transaction
load to the work processes.

■ Manages buffers in main memory.
■ Manages connections with the presentation

level.
■ Organizes the communication processes.

ABAP DispatcherApplication ServerSAP WebAS ABAP
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Table 2-1 SAP architecture (continued)

FunctionsServiceComponentArchitecture

■ Acts as a service offered by a server and
requested by a client

■ Acts as a special program in charge of
some specific tasks.

ABAP Work
processes

■ Manages logical locks.
■ Ensures server synchronization.

ABAP Enqueue
Service

Central Services
Instance

■ Central service for cluster internal
communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher.

■ Keeps a list of application servers that can
be reached within the system.

ABAP Message
Service

Enables the lock table to be replicated on a
second server, the replication server.

ABAP Enqueue
Replication Service

Enqueue Replication
Instance

Processes the requests and holds the session
data.

Java Server
Processes

Application ServerSAP WebAS Java

■ Manages logical locks.
■ Ensures server synchronization.

Java Enqueue
Service

Central Services
Instance

■ Acts as a central service for cluster internal
communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher.

■ Keeps a list of application servers that can
be reached within the system.

Java Message
Service

Enables the lock table to be replicated on a
second server, the replication server.

Java Enqueue
Replication Service

Enqueue Replication
Instance
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Table 2-1 SAP architecture (continued)

FunctionsServiceComponentArchitecture

■ Controls program that manages the
resources of R/3 applications.

■ Balances the assignments of the
transaction load to the work processes.

■ Manages buffer in main memory.
■ Connects to the presentation level.
■ Organizes the communication processes.

ABAP DispatcherApplication ServerSAP WebAS Add-In

■ Acts as a service offered by a server and
requested by a client.

■ Manages the programs that handle specific
tasks.

ABAP Work
processes

■ Handles the client-server processes and
maintains the session data.

Java Server
Processes

■ Manages logical locks
■ Ensures server synchronization

ABAP Enqueue
Service

Central Services
Instance ABAP

■ Acts as a central service for cluster internal
communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher

■ Keeps a list of application servers that can
be reached within the system.

ABAP Message
Service

■ Manages logical locks.
■ Ensures server synchronization.

Java Enqueue
Service

Central Services
Instance Java

■ Acts as a central service for cluster internal
communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher

■ Keeps a list of application servers that can
be reached within the system.

Java Message
Service

Enables the lock table to be replicated on a
second server, the replication server.

ABAP Enqueue
Replication Service

Enqueue Replication
Instance ABAP
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Table 2-1 SAP architecture (continued)

FunctionsServiceComponentArchitecture

Enables the lock table to be replicated on a
second server, the replication server.

Java Enqueue
Replication Service

Enqueue Replication
Instance Java

Remote component of end-to-end root cause
analysis.

SMDA ServiceSMDA InstanceSMDA

Single Point of Failures (SPOF)
In a distributed SAP environment, the following components are critical for application
availability. Hence, these components need to be protected.

■ Database Instance

■ Central Services Instance

■ Enqueue Replication Server

Table 2-2 lists the possibilities to eliminate the single point of failures.

Table 2-2 Possibilities to secure the single point of failures

Technical Possibilities to eliminate the SPOFSingle Point of Failure

Switch-over solutionsCentral Database

Set up an Enqueue Replication Server controlled by
a switch-over solution

Central Services

Switch-over solutionsEnqueue Replication Server

Switch-over solutionsSAP Central File System

Switch-over solutionsSolutionManager Diagnostics Agent
(SMDA)

Uniquely identifying SAPWeb Application Server
server instances

You can virtualize an SAP instance using a cluster. Using shared disk and virtual
IP addresses, you canmanage a large set of SAPWeb Application Server instances
in a single cluster.

For multiple instances running concurrently on a single node, the agent must be
able to uniquely identify each SAPWeb Application Server instance on that system.
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Each instance has a unique instance name. The instance names may follow the
conventional form. For example, additional application server instances begin with
'D', and Primary application server instances are typically named DVEBMGS.

Instance names often include an instance ID suffix which is an integer between
00-99. For example, an application server instance with an instance ID = 00 may
have an instance name of DVEBMGS00.

The SAPSID and InstName form a unique identifier that can identify the processes
running for a particular instance.

Some examples of SAP instances are given as follows:

InstTypeInstName

SAP Application Server - ABAP (Primary)DVEBMGS00

SAP Application Server - ABAP (Additional)D01

SAP Central Services - ABAPASCS02

SAP Application Server - JavaJ03

SAP Central Services - JavaSCS04

SAP Enqueue Replication ServerERS05

Solution Manager Diagnostics AgentSMDA97

Differentiating SAP instances is important to identify each instance uniquely. When
the agent kills the processes of a non-responsive or failed instance in absence of
unique names for each server, the agent may kill processes for more than one SAP
instance during a clean operation.

Monitoring an SAP instance
Themonitor operation performs process level check to ensure the proper functioning
of an SAP instance.

The ProcMon attribute specifies the processes that must be running successfully
for a particular SAP instance type. The monitor operation uses this list of processes
to scan the process table, and verify that the processes are running successfully.

Table 2-3 lists valid values of the ProcMon attribute
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Table 2-3 Values of ProcMon attribute

Value of ProcMon
attribute

SAP instance typeSAP usage type

enrepserver.exeENQREPABAP

jstart.exe

igswd.exe and icman.exe are
optional

APPSERVJava

enserver.exe

msg_server.exe

gwrd.exe is optional

ENQUEUEJava

enrepserver.exeENQREPJava

disp+work.exe

jstart.exe

igswd.exe, icman.exe and
gwrd.exe are optional

APPSERVAdd-In (ABAP + Java)

enserver.exe

msg_server.exe

ENQUEUE (ABAP)Add-In (ABAP +Java)

enrepserver.exeENQREP (ABAP)Add-In (ABAP +Java)

enserver.exe

msg_server.exe

gwrd.exe is optional

ENQUEUE (Java)Add-In (ABAP +Java)

enrepserver.exeENQREP (Java)Add-In (ABAP +Java)

jstart.exeSMDAJava

jstart.exeSMDAAdd-In (ABAP +Java)

The monitor operation takes a snapshot of the running processes table. The
operation compares the processes that the ProcMon attribute specifies, to the set
of running processes. If any process is missing, the operation declares the SAP
instance as offline, and bypasses further monitor operations.
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About installing SAP Web Application Server for
high availability

In a VCS environment, you can install SAP NetWeaver in the following ways:

Install the SAP instance binaries and SYS directory on
shared disks

SAP instance on shared disk

Install the SAP instance binaries on local disk and SYS
directory on shared disks

SAP instance on shared disk

When installing SAP NetWeaver, ensure that the login_name, group_name for the
sidadm and SAPServiceSID is the same on all the nodes.

For more details refer to SAP documentation.

About configuring SAP Web Application Server
for high availability

The guidelines for configuring SAP NetWeaver for high availability are as follows:

■ In a service group, keep the single point of failure as minimal as possible and
watch the application startup time.

■ Assign a virtual hostname to the component within the switchover environment.
Since the physical hostname changes with the switchover, this is a must have
requirement.

■ Based on the expected failover time configure the reconnection parameters for
all software components and enable its automatic reconnection.

■ Configure sapcpe to copy the instance specific executables and binaries from
a central file system to the instance executable directory, during the instance
startup.

Setting up SAP systems for clustering
This topic describes the procedure to install and configure SAP NetWeaver on a
Windows system, so that you can cluster the system in a Cluster Server (VCS)
environment.

Veritas recommends installing and clustering a database server for SAP to minimize
SAP system downtime. An SAP system downtime may happen due to database
unavailability.
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In this installation, it is assumed that you are setting up the system on two or more
nodes, and clustering these nodes in a VCS environment.

Note: Veritas strongly recommends that a trained SAP consultant be involved in
performing the installation procedure.

Installing SAP system using Virtual Hostname
An SAP system can be installed directly using virtual hostnames. To install SAP
system using virtual hostname, perform the following steps:

Note: Before installing SAP system refer to SAP Installation documentation.

To install SAP instances using Virtual Hostname

1 Log in as a user that has domain administrator rights.

2 Create a VCS Service Group with IP and Lanman resources for SAP instance.

For details about creating VCS Service Groups, refer to the VCS user
documentation.

3 Before beginning to install the SAP instance, bring the Service Group online.

4 On the node that has the Service Group online, start the SAP instance
installation.

Note: Do not double-click the sapinst.exe file to launch the SAP installation
GUI. Use the SAPINST_USE_HOSTNAME parameter to launch the SAP
installation GUI in a virtual environment.

5 Navigate to the directory where sapinst.exe tool is present in the Master DVD.

At the command prompt, run the following command:

path\sapinst.exe SAPINST_USE_HOSTNAME=Virtual Host Name

where,

Virtual Host Name is the virtual Lanman name that you created in step 2.

6 From the installation GUI, select the usage type of system you are
planning to install and follow the instructions to complete the installation.
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Configuring the agent for message server restart
In case the message server process fails, the Cluster Server agent for SAP Web
Application Server supports the message server restart through SAP service
(SAPSID_InstID) process sapstartsrv.exe

In case of unexpected termination, to avail the advantage of this restart technology
without failing over the entire (A)SCS instance, the SAP administrator must modify
the Instance profile for (A)SCS instance and set the new profile parameters.

Note: The Cluster Server agent for SAP Web Application Server does not support
restart of the ‘enserver.exe’ Enqueue server process.

To restart the message server, use the following syntax in the start profile:

Restart_Program_xx = local program name program arguments

For example, the modified syntax for the message server is as follows:

Restart_Program_02 = local $(_MS) pf=$(_PF)

By default sapstartsrv.exe restarts the message server without any delay.

For more information on how to restart the process of a program through
sapstartsrv.exe, refer to SAP Note 729945 and related notes.

Note: Veritas recommends that you carefully study the SAP note before you modify
the profile files for (A)SCS instance.

Configuring the Enqueue Replication Server
Configuration of the Enqueue Replication Server for SAP Web Application Server
can either be done manually, or by using SAPInst.

Configuring the Enqueue Replication Server manually
To manually configure the Enqueue Replication Server for SAP Web
Application Server

1 Enable replication in the (A)SCS instance by adding the following parameter
to the instance profile of (A)SCS instance:

(SAPSID_InstName_VirtualHostname).

enque/server/replication = true

Restart the (A)SCS instance to make the change effective.
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Let us assume a two-node software failover cluster, running on the physical
hosts—host A and host B, and a clustered (A) SCS instance with the following
parameters.

■ SCS SAPSID = PLL

■ SCS INSTNO = 01

■ SCS HOST = sapscshost (virtual host name)

This instance (that is, the Enqueue Server’s lock table) must be protected with
an ERS instance as follows:

■ ERS SAPSID = PLL

■ ERS INSTNO = 11 (a free instance number)

■ ERS HOST = sapershost (virtual hostname)

2 On one of the physical hosts ( host A or host B) perform the following steps as
user sidadm or domain administrator:

Create the directory structure as follows:

drive:\usr\sap\PLL\ERS11\exe

drive:\usr\sap\PLL\ERS11\log

drive:\usr\sap\PLL\ERS11\data

drive:\usr\sap\PLL\ERS11\work

3 Copy all the binaries from (A)SCS instance exe directory into the ERS instance
exe directory.
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4 Create a new ERS instance profile in drive:\usr\sap\PLL\SYS\profile.

SAPSYSTEMNAME = PLL

SAPSYSTEM = 11

INSTANCE_NAME = ERS11

DIR_CT_RUN = $(DIR_EXE_ROOT)\$(OS_UNICODE)\NTAMD64

DIR_INSTANCE = <drive>:\usr\sap\$(SAPSYSTEMNAME)\$(INSTANCE_NAME)

DIR_EXECUTABLE = $(DIR_INSTANCE)\exe

DIR_PROFILE = $(DIR_INSTALL)/profile

_PF = $(DIR_PROFILE)\PLL_ERS11_sapershost

SAPGLOBALHOST = sapscshost

SAPLOCALHOST = sapershost

#----------------------------------------------------------------

# Copy SAP Executables

#----------------------------------------------------------------

_CPARG0 = list:$(DIR_CT_RUN)/scs.lst

Start_Program_01 = immediate $(DIR_CT_RUN)\sapcpe$(FT_EXE) pf=$(_PF)

$(_CPARG0)

#-----------------------------------------------------------------

# Settings for enqueue monitoring tools (enqt, ensmon)

#-----------------------------------------------------------------

enque/process_location = REMOTESA

rdisp/enqname = $(rdisp/myname)

#-----------------------------------------------------------------

# standalone enqueue details from (A)SCS instance

#-----------------------------------------------------------------

SCSID = 01

SCSHOST = sapscshost

enque/serverinst = $(SCSID)

enque/serverhost = $(SCSHOST)

enque/serverport = 32$(SCSID)

enque/enrep/poll_interval = 0

enque/enrep/poll_timeout = 120

enque/enrep/inactive_action = sleep

#-----------------------------------------------------------------

# Start enqueue replication server

#-----------------------------------------------------------------
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_ER = $(DIR_EXECUTABLE)\enrepserver$(FT_EXE)

Start_Program_02 = local $(_ER) pf=$(_PFL) NR=$(SCSID)

For DIR_CT_RUN in this ERS profile, take the value DIR_CT_RUN from the
(A)SCS instance profile. If the (A)SCS instance has not configured
DIR_CT_RUN in its profiles, take the value specified for DIR_EXECUTABLE
from the (A)SCS instance profile.

It is essential that the binaries from (A)SCS and ERS instance are from the
same binary set.

5 Use the sapstartsrv.exe command to create an SAP Windows Service for
the Enqueue Replication Server instance.

6 Start the SAP instance for the Enqueue Replication Server. Ensure that the
instance starts successfully.

The SAP instance is now ready for clustering and to control the life time of
Enqueue Replication Server using VCS.

Configuring the Enqueue Replication Server using SAPInst
To configure the Enqueue Replication Server for SAP NetWeaver using
SAPInst

1 Install Enqueue Replication Server using SAPInst with virtual hostname.

# sapinst SAPINST_USE_HOSTNAME=VirtualHostName

2 Modify the Enqueue Replication Instance profile

drive:\usr\sap\SAPSID\SYS\profile\SAPSID_InstName_VHostName

3 Add the following lines under the section "standalone enqueue details from
(A)SCS instance" in the profile file.

enque/poll_interval = 0

enque/poll_timeout = 120

enque/enrep/inactive_action = sleep

enque/table_size = 4096

4 Delete the following lines from the profile file.

Autostart = 1

enque/enrep/hafunc_implementation
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5 Change the Restart_Program_00 to Start_Program_00 Under "Start enqueue
replication server" section.

Start_Program_00 = local $(_ER) pf=$(_PFL) NR=$(SCSID)

6 Control the life time of Enqueue Replication Server using the switchover
solution.

Clustering an SAP instance
This section describes the procedure for clustering an SAP instance.

To cluster an SAP instance, you must first configure the node that hosts the SAP
Central Service Instance ([A]SCS) and then configure all other nodes that you want
to cluster.

Configuring the first node in the cluster
Perform the following tasks on the node on which you installed SAP, the first time.

■ Set the SAP Service to manual.

■ Create the cluster service group for SAP instance.

To configure the first node in the cluster

1 Stop the SAP Central Services Instance.

2 Stop the SAP instance Windows service

SAPSAPSID_No

3 In the instance profile, set the AUTOSTART equal to 0.

4 Configure the SAPSAPSID_No service as follows:

■ Open services.msc. Click Start > Run and enter service.msc.

■ On the Services panel, right-click the SAPSAPSID_No service, and select
Properties.

■ On the General tab, select Manual from the Startup type drop-down list.

■ Click OK.

■ Close and exit the Services panel.

Configuring all other nodes in the cluster
Perform the following tasks on the other remaining cluster nodes:

■ Create the required SAP users and groups.
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■ Set the system and user environment for the SAP system.

■ Enter the required port numbers in the Windows services files.

■ Install Host Agent using sapinst.exe.

■ Create the Windows service for the SAP instance.

To configure all other nodes in the cluster

1 Log in as a domain administrator.

2 Create the following local groups.

■ SAP_SAPSID_LocalAdmin

■ SAP_SAP_LocalAdmin

■ SAP_LocalAdmin

3 Add the SAP_SAPSID_GlobalAdmin domain group to the
SAP_SAPSID_LocalAdmin and SAP_LocalAdmin group.

4 Add the SAP_SAP_GlobalAdmin domain group to the SAP_SAP_LocalAdmin
and SAP_LocalAdmin

5 Add the SAP_SAPSID_GlobalAdmin and SAP_SAP_GlobalAdmin domain
group to the local Administrators group.

For details on creating and adding a new local group and users:

See “Creating and adding local groups and users” on page 39.

6 Click Start > Programs > Administrative Tools > Local Security Policy >
Local Policies > User Right Assignment.

7 Add the following privileges for the sapsidadm user.

■ Act as a part of the Operating System (SeTcbPrivilege)

■ Replace a process-level token (SeAssignPrimaryTokenPrivilege)

■ Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

8 Add the following privileges for the SAPServiceSAPSID user.

■ Log on as a Service (SeServiceLogonRight).

■ Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

■ Access this computer from the network (SeNetworkLogonRight)

■ Deny Log on Locally and Deny Log on through Terminal Services
(SeDenyInteractiveLogOnRight)

9 Change the sapsidadm user environment as follows:
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■ At the command prompt enter,
runas /profile /user:domain\sapsidadm regedit

■ On the Registry Editor panel, click HKEY_CURRENT_USER >
Environment.

■ Modify the user environment based on your Database, SAP Usage Type
and SAPSID.

For example, the following table depicts the registry environment with Oracle
database (PI1) and Add-In installation with SAPSID PI1.

DataTypeName

value not setREG_SZDefault

oraREG_SZDBMS_TYPE

SAPSR3REG_SZdbs_ora_schema

PI1REG_SZdbs_ora_tnsname

C:\j2sdk1.4.2_19-x64REG_SZJAVA_HOME

AMERICAN_AMERICA.UTF8REG_SZNLS_LANG

E:\oracle\PI1\102REG_EXPAND_SZORACLE_HOME

PI1REG_EXPAND_SZORACLE_SID

E:\usr\sap\PI1\SYS\exe\uc\NTAMD64;\

\sappi1scs\sapmnt\PI1\SYS\exe\uc\NTAMD64;

E:\oracle\PI1\102\BIN

REG_EXPAND_SZPATH

E:\oracle\PI1REG_EXPAND_SZSAPDATA_HOME

\\sapi1scs\sapmnt\PI1\SYS\exe\uc\NTAMD64REG_SZSAPEXE

sappi1aasREG_SZSAPLOCALHOST

PI1REG_SZSAPSYSTEMNAME

E:\usr\sap\PI1\tmpREG_EXPAND_SZTEMP

E:\usr\sap\PI1\tmpREG_EXPAND_SZTMP

\\sappi1scs\sapmnt\PI1\SYS\profile\oracleREG_EXPAND_SZTNS_ADMIN
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10 From the first node in the cluster, copy the following service entries for the SAP
instance, from the services file in the %windir%\system32\drivers\etc

directory to the corresponding services file on all other nodes in the cluster.

sapdp<No.> 32<No.>/tcp # SAP System Dispatcher Port

sapdp<No.>s 47<No.>/tcp # SAP System Dispatcher Security Port

sapgw<No.> 33<No.>/tcp # SAP System Gateway Port

sapgw<No.>s 48<No.>/tcp # SAP System Gateway Security Port

sapms<SAPSID> 36<No.>/tcp # SAP System Message Port Number

where,

The value for <No.> is the value of an Instance ID.

11 Move the Service Group from the first node to the node that you are currently
configuring and ensure that the drive:\usr\sap directory is shared with the
names, sapmnt and saploc.

See “Creating sapmnt and saploc share directories” on page 39.

12 Install SAP Host Agent with SAPInst. Follow the steps below to install the SAP
Host agent.

■ In the Master DVD, navigate to the directory containing the sapinst.exe tool.

■ Double-click the sapinst.exe file to launch the SAP installation GUI.

■ Select High Availability System > Based on [AS ABAP/AS Java/AS
ABAP and AS Java] > Host Agent based on the usage type of system
you installed.

■ Follow the instructions to complete the installation.

13 Create the SAPSAPSID_No service as follows:

■ At the command prompt, navigate to the
drive:\usr\sap\SAPSID\InstName\exe directory.

■ Run the sapstartsrv.exe command.

■ In the SAP Service Install/Uninstall dialog box, enter the following values:

SAPSIDSID

InstanceNumberNR
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If, SAPLOCALHOST=SAPGLOBALHOST, then enter the value
as:

drive:\usr\sap\SAPSID
\SYS\profile\SAPSID_InstName
_VirtualHostName

If, SAPLOCALHOST is not equal to SAPGLOBALHOST, then
enter the value as:

\\SAPGLOBALHOST\sapmnt\SAPSID
\SYS\profile\SAPSID_InstName
_VirtualHostName

Profile

domain\SAPServiceSAPSIDUser

SAPServiceSAPSID passwordPassword

manualStartup type

domain\sapsidadmUse
Environment of
User

14 Click OK.

15 Re-register the type library as follows:

■ At the command prompt, navigate to the Drive:\Path\SAP\hostctrl\exe
directory.

■ Run the sapstartsrv.exe command.

■ In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field

■ Click OK.
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16 Create registry entries for the SAPSAPSID_No service.

For example,

DataTypeName

value not setREG_SZDefault

\\sappi1scs\sapmnt\PI1\SYS\exe\

uc\NTAMD64\sapevents.dll

REG_SZEventMessageFile

0x00000007(7)REG_DWORDTypesSupported

17 If an SAP Microsoft Management Console (MMC) is not configured on the
node, register the SAP MMC using the following steps:

■ Access the file sapmmcX64u.msi or sapmmcIA64u.msi from Kernel Install
DVD depending on the OS architecture.

■ Install SAP MMC by executing the msi package.

Note: Veritas recommends that you cluster the SAP Central Services instances for
both ABAP and Java in an Add-In Usage Type in the same service group.

Also, cluster the Enqueue Replication servers for both ABAP and Java in an Add-In
Usage Type in a single Service Group.

Creating and adding domain groups and users
If you do not have domain administrator rights, you can perform the SAP instance
installation and configuration as a domain user who is a member of the local
administrator group.

User accounts
The SAPInst tool creates the following accounts for the SAP system administrator:

This user account is the SAP system administrator account. This
account enables interactive administration of the system.

sapsidadm

This user account is required to start the SAP system. This account
has the local user right to log on as a service.

This account does not allow interactive logon. You need not set
an expiry date for the password. However, you must change the
password at the next logon option.

SAPServiceSID
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Groups
The SAPInst tool creates the following groups during domain installation:

This global group is a domain level SAP administration group for
organizing SAP system administrators. This global group, groups
together the users at the domain level so that they can be placed
in appropriate local groups.

SAP_SAPSID_GlobalAdmin

These are local groups created and maintained on an application
server. A local group has rights only to the system on which the
group is located.

The system on which the local group is located is part of a
particular domain. The local group can contain users and global
groups from this domain.

SAP_SAPSID_LocalAdmin

Though this group is created on all hosts, creating this group on
the transport host is necessary. Members of this group have full
control over the transport directory, drive:\usr\sap\trans. This
directory allows transports to take place between systems.

The SAP_SAPSID_GlobalAdmin groups of all the SAP systems
that are part of the transport infrastructure are added to the
SAP_LocalAdmin group. Therefore, the sapsidadm and
SAPServiceSAPSID users of all systems in the transport
infrastructure are members of the SAP_LocalAdmin group. These
users have the rights necessary to initiate and execute transports.

SAP_LocalAdmin

Adding new domain groups and users
This section describes the procedure to add new domain groups and users. You
can perform this procedure as a domain administrator only.

To create the SAP_SAPSID_GlobalAdmin Global group

1 Log in as a domain administrator on to Domain Controller.

2 Click Start > Programs > Administrative Tools > Active Directory Users
and Computers.

Alternatively,

■ Click Start > Run.

■ In the Open field, enter mmc.

■ In the Console window, click File > Add/Remove Snap-in.

■ In the Add/Remove Snap-in dialog box, click Add.
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■ In the Add Standalone Snap-in dialog box, select Active Directory Users
and Computers.

■ Click Add.

■ Click OK.

3 In the Active Directory Users and Computers dialog box, right-clickUsers, and
select New > Group.

4 In the New Object - Group dialog box, enter the following values:

SAP_SAPSID_GlobalAdmin

Specify this value using the exact and correct uppercase
and lowercase.

Group Name

GlobalGroup scope

SecurityGroup type

5 Click OK.

Creating SAP system users, sapsidadm and
SAPServiceSAPSID
Follow the steps below to create the SAP system users:

To create the SAP system users

1 In the Active Directory Users and Computers dialog box, right-clickUsers, and
select New > User.

2 In the New Object - User dialog box, enter the following values for sapsidadm

NAFirst name

NAInitials

NALast name

sapsidadmFull name

sapsidadmUser logon
name

3 Click Next.

4 Enter the password and confirm the password.

37Installing and configuring the SAP Web Application Server for high availability
Clustering an SAP instance



5 Select Password never expires.

Ensure that no other option is selected.

6 Click Next.

7 Click Finish.

Adding the sapsidadm user to the
SAP_SAPSID_GlobalAdmin Group
To add the sapsidadm user to the SAP_SAPSID_GlobalAdmin Group

1 In the Active Directory Users and Computers dialog box, double-click sapsidadm
under Users.

2 In the sapsidadm Properties dialog box, click Member > Add.

3 In the Select Groups dialog box, select SAP_SAPSID_GlobalAdmin

4 Click Add.

Note: By default, this user is also a member of the Domain Users group.

5 Click OK.

To add the SAPServiceSAPSID user to the
SAP_SAPSID_GlobalAdmin Group
To add the SAPSID service user to the SAP_SAPSID_GlobalAdmin Group

1 In the Active Directory Users and Computers dialog box, double-click
SAPServiceSAPSID under Users.

2 In the SAPServiceSAPSID dialog box, click Member > Add.

3 In the Select Groups dialog box, select SAP_SAPSID_GlobalAdmin.

4 Click Add.

5 Remove the user from the Domain users group.

■ From the Member of list, select SAP_SAPSID_GlobalAdmin

■ Select Set Primary Group

■ Select Domain Users

■ Click Remove to delete the Domain Users group from the Member of list

■ Click OK

■ Exit the Active Directory Users and Computers dialog box.
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Creating and adding local groups and users
This section describes the procedure to add new local groups and users.

Note: This procedure may vary for Windows Server 2008.

To create a local group

1 ClickStart >ControlPanel >Administrative tools >ComputerManagement.

2 In the Computer Management dialog box, select Local Users and Groups.

3 Right-click Group, and select New Group.

4 In the New Group dialog box, enter SAP_SAPSID_LocalAdmin in the Group
name field.

5 Click Add.

6 In the Select Users, Computers or Groups dialog box, enter
domain\SAP_SAPSID_GlobalAdmin in the Object names field.

7 Click OK on the Select Users, Computers, or Groups dialog box.

8 Click OK on the New Group dialog box

To add a domain group to a local group

1 ClickStart >ControlPanel >Administrative tools >ComputerManagement.

2 In the Computer Management Console, select Local Users and Groups
>Groups.

3 In the right panel, double-click Administrators.

4 In the Administrators Properties dialog box, click Add.

5 In the Select Users, Computers, or Groups dialog box,
enterdomain\SAP_SAPSID_GlobalAdmin in the Object names field.

6 Click OK in the Select Users, Computers, or Groups dialog box.

7 Click OK in the Administrators Properties dialog box.

Creating sapmnt and saploc share directories
Ensure that the sapmnt and saploc directories are shared, and are accessible by
the SAP system Administrator.
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To create the sapmnt and saploc share directories on Windows Server
2008/2012

1 Right-click the drive:\usr\sap directory, and select properties.

2 On the Properties dialog box, click the Sharing tab.

3 Click Advanced Sharing.

4 Select Share this folder option.

5 Enter sapmnt in the Share name field.

6 Click Permissions.

7 In the Permissions for sapmnt dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the sapmnt directory.

8 Click OK in the Permissions for sapmnt dialog box.

9 In the Properties dialog box, click Advanced Sharing.

10 On the Advanced Sharing dialog box, click Add.

11 On the New Share dialog box, enter saploc in the Share name field.

12 Click OK in the New Share dialog box.

13 Click Permissions.

14 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

15 Click OK in the Permissions for saploc dialog box.

16 Click OK in the New Share dialog box.

17 Click OK in the Advanced Sharing dialog box.

18 Click Close in the Properties dialog box.

Configuring the SAP systems onWindows Server
2008/2012

On Windows Server 2008/2012, you can only access file shares pointing to local
disks with the physical computer name. To be able to define file shares pointing to
shared disks, a “client access point” (one IP address associated with one network
name cluster resource) must already exist in the failover cluster service group to
which the shared disk belongs. Since you can only access file shares pointing to
shared disks with the network name that belongs to the same failover cluster service
group, you can create multiple file shares with the same file share name (for
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example, sapmnt) in a failover cluster environment, assuming the file shares belong
to different cluster service groups.

Figure 2-1 shows a typical SAP system installation on aWindows Server 2008/2012
system under VCS environment.

Figure 2-1 Typical SAP system installation (usingmultiple sapmnt file shares)
on aWindows Server 2008/2012 system under VCS environment

For sample service group configurations on Windows Server 2008/2012,

See “Sample service group configurations for SAP systems on Windows Server
2008/2012” on page 78.
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Installing, upgrading, and
removing the agent for
SAP Web Application
Server

This chapter includes the following topics:

■ Before you install the agent for SAP Web Application Server

■ Installing the agent for SAP Web Application Server

■ Removing the agent for SAP Web Application Server

■ Upgrading the agent for SAP Web Application Server

Before you install the agent for SAP Web
Application Server

Before you install the Cluster Server agent for SAPWeb Application Server, ensure
that you install and configure the VCS on all nodes in the cluster.
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Installing the agent for SAP Web Application
Server

Note: By default, the SAP Web Application Server agent is installed along with
VCS 6.1.You can upgrade the SAP Web Application Server agent to the latest
Agent Pack release that is available.

The agents for both SAPNetWeaver and SAPWeb Application Server are combined
in a single package. Thus, if you install either of the agents, the other agent gets
installed by default.

To install the VCS agent for SAP Web Application Server

1 Log on to any node in the cluster.

Ensure that the logged on user has the domain administrative privileges.

2 Download the Agent Pack from the Symantec Operations Readiness Tools
(SORT) site: https://sort.veritas.com/agents.

You can download the complete Agent Pack tar file or the individual agent tar
file.

3 Uncompress the file to a temporary location.

4 If you downloaded the complete Agent Pack tar file, navigate to the directory
containing the package for the platform running in your environment.

cd1\windows\w2k8x64\vcs\application\sapwebas_agent\
vcs_version\version_agent\Pkgs

Windows 2008 (x64)

cd1\windows\w2k12x64\vcs\application\sapwebas_agent\
vcs_version\version_agent\Pkgs

Windows 2012 (x64)

5 Double-click vrtsvcssap.msi.

6 Follow the instructions that the install program provides, to complete the
installation of the Cluster Server agent for SAP Web Application Server.
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Removing the agent for SAP Web Application
Server

Perform the following procedure to uninstall the agent for SAP Web Application
Server from a cluster. Perform these steps while the cluster is active.

Note: The agent for SAP NetWeaver and SAP WebAS are combined in a single
package. Thus, removing one agent package will remove the other by default.

Note: If you remove the SAP WebAS agent, the default agent installed with VCS
6.1 is also removed.

To uninstall the VCS agent for SAP Web Application Server

1 Ensure that all clustered SAP resources are offline.

2 From the cluster, remove all the resources that use the agents for SAP Web
Application Server.

3 Perform the following steps on each node from which you want to uninstall the
agent. Ensure that you have a user with administrative privileges.

■ Click Start > Settings > Control Panel.

■ On Windows 2008: Navigate to Programs and Features

■ On Windows 2008R2/2012: Navigate to Programs>Programs and
Features

■ From the list of programs, select vrtsvcssap.msi.

4 Click Change/Remove.

5 Follow the instructions that the uninstall program provides, to complete the
uninstallation of the agents for SAP Web Application Server.

Upgrading the agent for SAP Web Application
Server

Perform the following steps to upgrade the agent with minimal disruption, in a VCS
environment.
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To upgrade the agent in a VCS environment

1 Login as domain administrator.

2 Verify that your path is drive:\Program Files\Veritas\Cluster Server\bin

3 Persistently freeze all the service groups that host the application:

C:\> hagrp –freeze GroupName -persistent

4 Stop the SAP WebAS agent forcibly:

C:\> haagent -stop SAPWebAS -force -sys SystemName

5 Ensure that the agent operations are stopped on all the nodes.

6 Take a back up of the main.cf and types.cf files:

C:\> copy drive:\> Program Files\Veritas\Cluster

Server\conf\config\main.cf drive:\>backup\main.cf

C:\> copy drive:\> Program Files\Veritas\Cluster

Server\conf\config\types.cf drive:\>backup\types.cf

7 Install the new agent on all the nodes.

8 Ensure that the logged on user has the domain administrative privileges.

9 Download the Agent Pack from the Symantec Operations Readiness Tools
(SORT) site:https://sort.veritas.com/agents.

You can download the complete Agent Pack tar file or the individual agent tar
file.

10 Uncompress the file to a temporary location.

11 If you downloaded the complete Agent Pack tar file, navigate to the directory
containing the package for the platform running in your environment:

cd1\windows\w2k8x64\vcs\
application\sapwebas_agent\vcs_version\
version_agent\Pkgs

Windows 2008 (x64)

cd1\windows\w2k12x64\vcs\
applicationsapwebas_agent\ vcs_version\
version_agent\Pkgs

Windows 2012 (x64)

12 Double-click vrtsvcssap.msi.

13 Select Modify and follow the instructions that the install program provides to
upgrade the Veritas agent for SAP Web Application Server.
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14 Navigate to drive:\> Program Files\Veritas\Cluster Server\conf\config\types.cf
file and verify if any duplicate type definitions exists for SAP Web Application
Server on all the nodes.

If duplicate type definitions exist, remove old type definition from types.cf file
and save the file.

Note: To identify the old type definition, compare the new type definition file
with the old (backed up) types.cf file.

15 Check for the changes in the resource values required, if any, due to the new
agent types definition.

Note: To note the list of changed attributes, compare the new type definition
file with the old type definition file.

16 Start the agent on all nodes:

C:\> haagent -start SAPWebAS -sys SystemName

17 Unfreeze the service groups once all the resources come to an online steady
state:

C:\> hagrp -unfreeze GroupName -persistent
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Configuring the agent for
SAP Web Application
Server

This chapter includes the following topics:

■ About configuring the agent for SAP Web Application Server

■ Agent attributes for SAP Web Application Server

■ Setting the SAPMonHome attribute

■ Configuring the execution period for agent functions

■ Executing a custom monitor program

■ Preventing early faulting of Java and Add-In instances

About configuring the agent for SAP Web
Application Server

To provide high availability for SAPNetWeaver components in the VCS environment,
you must first configure the VCS resources of type SAPWebAS.

After installing the Agents for SAP NetWeaver, you can create and configure the
SAP resources. Before you configure a resource, review the attributes table that
describes the SAPWebAS resource type and its attribute definitions.

See “Agent attributes for SAP Web Application Server” on page 48.
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Agent attributes for SAP Web Application Server
In a virtual environment, the Symantec High Availability Configuration Wizard
discovers the required attributes. You can use CLI commands to configure any of
the optional attributes.

Table 4-1 shows the required attributes for configuring a SAP Web Application
Server instance.

Table 4-1 Required attributes

DescriptionRequired attributes

The logging detail performed by the agent for the resource. The
valid values are:

INFO: Logs error messages

TRACE: Logs error and trace messages. TRACE is very verbose
and should only be used during initial configuration or for
troubleshooting and diagnostic operations.

Type and dimension: string-scalar

Default: INFO

Example: TRACE

ResLoglevel

Windows user name used to start the SAP instance. This user must
be dedicated to all the SAP instances within an SAP system. The
format is sapsidadm.

Type and dimension: string-scalar

Default: No default value

Example: piladm

SAPAdmin

Windows domain name to which the SAPAdmin user belongs.

Note: If SAPAdmin does not belong to a Windows domain, use
the cluster localization settings to specify the local computer name
for each system.

Type and dimension: string-scalar

Default: No default value

Example: SYMCORP

SAPAdminDomain
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Table 4-1 Required attributes (continued)

DescriptionRequired attributes

Password for the SAPAdmin user.

Use the vcsencrypt -agent command to encrypt the password.
If you are using the VCS GUI, the GUI automatically encrypts the
password.

Type and dimension: string-scalar

Default: No default value

Example: vxfgh28skbsj

SAPAdminPassword

Virtual IP host name (LANMAN name) for the SAP instance. If the
instance is installed with location hostname, use the local system
name as this attribute value.

Type and dimension: string-scalar

Default: No default value

Example: sappi1scs

SAPHost

The absolute path to the SAP base directory. This attribute is used
to locate programs that the agent uses for start, stop, and clean
functions.

Example 1: C:\usr\sap\PI1\DVEBMSG00\exe

Example 2: C:\usr\sap\PI1\ASCS01\exe

Default: No default value

SAPHome

Windows user name used to start the SAP Windows service for an
SAPSID. This user must be dedicated to all the SAP services under
one SAP system, and must not be used by any other SAP service
or instance under a different SAP system, even in the same cluster.

Note: Do not include the domain name in the value for this attribute.
Use the SAPAdminDomain attribute to specify domain information.

Type and dimension: string-scalar

Default: No default value

Example: SAPServicePI1

SAPServiceUser
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Table 4-1 Required attributes (continued)

DescriptionRequired attributes

SAP system name. This attribute starts with an alphabetic character
and is exactly 3 characters in length. Ensure that the alphabetic
characters used in this attribute are in uppercase only. SAPSID is
defined during the SAP installation.

Type and dimension: string-scalar

Default: No default value

Example: PI1

SAPSID

String identifier that classifies and describes the SAP server instance
type. The InstType values are not case sensitive.

The valid values are:

APPSERV: SAP Application Server

ENQUEUE: SAP Central Services

ENQREP: SAP Enqueue Replication Server

SMDA: Solution Manager Diagnostics Agent

Type and dimension: string-scalar

Default: APPSERV

Example: ENQUEUE

InstType

Uniquely identifies an SAP server instance, along with the SAPSID
attribute. The last two characters of this attribute specify the value
of the InstID attribute. The InstID and SAPSID attributes together
uniquely identify an SAP instance.

Some examples include the following:

■ ASCS03: SAP Central Services (ABAP)
■ SCS07: SAP Central Services (Java)
■ DVEBMGS00: SAP Primary Application Server (ABAP)
■ D05: SAP Additional Application Server (ABAP)
■ J06: SAP (Primary/Additional) Application Server (Java)
■ ERS04: SAP Enqueue Replication server
■ SMDA97: Solution Manager Diagnostics Agent

Type and dimension: string-scalar

Default: ""

Example: DVEBMGS00

InstName
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Table 4-1 Required attributes (continued)

DescriptionRequired attributes

Specifies the full path and file name of the SAP Instance Profile.
Typically the InstProfile is found in
C:\usr\sap\SAPSID\SYS\profile and has a name of
SAPSID_InstName_hostname.

Type and dimension: string-scalar

Default: No default value

Example: C:\usr\sap\PI1\SYS\profile\PI1_DVEBMGS00_sappi1pas

InstProfile

The list of SAP processes that the monitor function must monitor
during a first-level check of an SAP instance. The entries in this list
are separated by a space and can be specified in any order. The
valid values are:

APPSERV: disp+work.exe igswd.exe jstart.exe gwrd.exe icman.exe

ENQUEUE: msg_server.exe enserver.exe gwrd.exe

ENQREP: enrepserver.exe

SMDA: jstart.exe

Type and dimension: vector-scalar

Default: No default value

Example: disp+work.exe

ProcMon

The directory that defines the location of the sapcontrol.exe or
ensmon.exe commands. The agent for SAP WebAS uses these
commands for second-level monitoring.

This functionality is not a part of the base SAP installation. Hence,
the value of this attribute may be different from the SAPHome
attribute.

Type and dimension: string-scalar

Default: No default value

Example: C:\usr\sap\AAV\SYS\exe\uc\NTAMD64

SAPMonHome
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Table 4-1 Required attributes (continued)

DescriptionRequired attributes

Specifies the SAPCentral Services instance resource name in VCS.
This attribute is set only for Enqueue Replication Server (ERS) and
will be used by both Enqueue and Enqueue Replication Servers to
query others status during startup and failover.

Type and dimension: string-scalar

Default: No default value

Example: SAPPI1SCS_scs

EnqSrvResName

Table 4-2 shows the optional attributes for configuring an SAP Web Application
Server instance.
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Table 4-2 Optional attributes

DescriptionAttribute

Used to enable second-level monitoring and specify the interval
for the same. Second-level monitoring is a deeper, more thorough
state check of the configured SAP instance. The numeric value
specifies how often the second-level monitoring routines are run.
0 means never run the second-level monitoring routines, 1 means
run routines every monitor interval, 2 means run routines every
second monitor interval, and so on.

Note: Exercise caution while setting SecondLevelMonitor to large
numbers. For example, if the MonitorInterval is set to 60 seconds
and the SecondLevelMonitor is set to 100, then sapcontrol is
executed every 100 minutes, which may not be as often as
intended. For maximum flexibility, no upper limit is defined for
SecondLevelMonitor.

For Java and Add-In systems, if SecondLevelMonitor is enabled
and if resources are going to unknown state, change ResLogLevel
to TRACE. After you change ResLogLevel to TRACE, you might
encounter the following error message:

J2EEGetProcessList FAIL: HTTP error, HTTP/1.1 401
Unauthorized.

If you encounter the above-mentioned error message, edit the
instance profile, add the following parameter, and restart the
instance service:

service/protectedwebmethods =

Type and dimension: integer-scalar

Default: 0

Example: 1

SecondLevelMonitor
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Table 4-2 Optional attributes (continued)

DescriptionAttribute

Full path and file name of an external, user-supplied monitor
program. If specified, the monitor function executes this file to
perform an additional server state check. There are no restrictions
for what actions the external monitor program performs, to
determine the state of a SAP instance server. The only constraint
is that the external monitor programmust return one of the following
integer values:

■ 0 (server is online)
■ 110 (server is online)
■ 100 (server is offline)
■ 1 (server is offline)
■ 99 or anything else (server state is unknown)

Note: Veritas recommends storing the external monitor program
in the shared disk directory to ensure the file is always available
on the online system. Arguments are supported.

Type and dimension: string-scalar

Default: No default value

Example 1: C:\usr\sap\PI1\DVEBMGS00\work\mymonitor.bat

Example 2: C:\usr\sap\PI1\DVEBMGS00\work\mymonitor.exe arg1
arg2

MonitorProgram

Setting the SAPMonHome attribute
The SAPMonHome attribute contains the absolute path to the directory that contains
the binary used for second level monitoring process.

The binaries that are used during second-level monitoring for different SAP usage
types and SAP instances are as follows:

■ For ABAP application Server: sapcontrol.exe

■ For Add-In (ABAP + Java) application server: sapcontrol.exe

■ For Enqueue and Enqueue Replication Server: ensmon.exe

Note: For Java application server and java component of Add-In application server
the agent uses the sapcontrol.exe utility present in SAPHome.
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Configuring the execution period for agent
functions

An agent function is allocated an execution period using the respective time-out
attributes: OnlineTimeout, OfflineTimeout, MonitorTimeout, and CleanTimeout. By
default these values are set to 300, 300, 60 and 60 respectively.

If an agent function executes a program, for example sapcontrol.exe, the program
must execute within the allocated execution period. If the program is unable to
execute within the allocated period, the agent function cancels and terminates the
execution of the program. You must set these timeout attributes to appropriate
values depending on the time required for SAP applications. You can modify these
values with the following command.

hatype -modify TypeName attribute_name attribute_value

Example: C:\> hatype -modify SAPWebAS OnlineTimeout 600

Executing a custom monitor program
Themonitor function executes a custommonitor program to perform a user-defined
SAP WebAS state check.

The monitor function executes the MonitorProgram if the following conditions are
true:

■ The specified utility is a valid executable file.

■ The first level process check indicates that the SAP Web AS instance is online.

■ The SecondLevelMonitor attribute is either set to 0 or 1, and the second level
check indicates that the SAP Web AS instance is online.

■ The SecondLevelMonitor attribute is set to greater than 1, but the second level
check is deferred for this monitoring cycle

The monitor operation interprets the program exit code as follows:

SAP server instance is ONLINE110 or 0

SAP server instance is OFFLINE100 or 1

SAP server instance is UNKNOWN99

SAP server instance is UNKNOWNAny other value
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To ensure that the custom monitor program is always available to the agent
application, Veritas recommends storing the file in a shared directory that is available
on an online node.

Preventing early faulting of Java and Add-In
instances

When you start a SAP Java or a SAP Add-In Application Server Instance, SAP
automatically starts processes such as jstart.exe. Depending upon the available
resources, starting these processes takes some finite time.

The agent for SAP WebAS allows enough time for SAP to start these processes
successfully. The agent checks the status of these processes in definite intervals.
While checking the status of these processes, if the processes are missing, the
agent pauses for a time period that is equal to one-tenth of the value of the
MonitorTimeout attribute before re-checking the status of the processes.

Veritas strongly recommends that the administrator set the MonitorTimeout attribute,
such that the agent gives enough time for these processes to restart if a failure
occurs.

For example, if an add-in server instance takes 9 seconds to restart a failed jstart
process, you must set the value of the MonitorTimeout attribute to at least 90
seconds.
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Configuring the service
groups for SAP Web
Application Server

This chapter includes the following topics:

■ About configuring service groups for SAP Web Application Server

■ Before configuring the service groups for SAP Web Application Server

■ Configuring service groups with the SAP Web Application Server agent

■ Configuring the SAPWebAS preonline script

About configuring service groups for SAP Web
Application Server

Configuring the SAP Web Application Server service group involves creating the
SAP service group, its resources, and defining attribute values for the configured
resources. You must have administrator privileges to create and configure a service
group.

You can configure the service groups using one of the following:

■ The Cluster Manager (Java console)

■ Veritas Infoscale Operations Manager

■ The command line
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Before configuring the service groups for SAP
Web Application Server

Before you configure the SAP Web Application Server service group, you must
perform the following:

■ Verify that VCS is installed and configured on all nodes in the cluster where you
will configure the service group.
Refer to the product installation guide for more information on installing and
configuring VCS.

■ Verify that SAP NetWeaver is installed and configured identically on all nodes
in the cluster.
See “About installing SAP Web Application Server for high availability”
on page 24.
See “About configuring SAP Web Application Server for high availability”
on page 24.

■ Verify that the Cluster Server agent for SAP Web Application Server is installed
on all nodes in the cluster.

Configuring service groups with the SAP Web
Application Server agent

While setting up a cluster, you must always ensure that the cluster has some spare
capacity to handle the SAP NetWeaver failover scenarios. For example, in case of
a back-end database failure, the cluster must be able to run another database
instance in conjunction with other running applications. Review the information
about data protection.

The cluster should thus be able to provide application failover by encapsulating the
resources required for an application into a service group. A service group is a
virtualized application that can switch between the cluster nodes. It contains a set
of dependent resources, such as disk groups, disk volumes, file systems, IP
addresses, NIC cards, and dependent application processes. It also includes logic
about the dependencies between the application components.

These service groups should thus be configured such that the cluster can start,
stop, monitor, and switch the service groups between the nodes, depending upon
the server or resource faults. An administrator should also be pro-actively able to
move a service group between cluster nodes to perform preventative maintenance
or apply patches.
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To configure the service groups

1 Change the cluster configuration to read/write mode.

C:\> haconf -makerw

2 Create a service group for SAP NetWeaver

C:\> hagrp -add SAP710-PI1SCS

3 Modify the SystemList attribute for the group, to add systems.

C:\> hagrp -modify SAP710-PI1SCS SystemList vcswin74 0 vcswin75

1

4 Create resources for NIC, IP, Lanman,VMDg, and MountV in the service group.

C:\> hares -add SAP710-PI1SCS_nic NIC SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_ip IP SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_lanman Lanman SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_mnt MountV SAP710-PI1SCS

C:\> hares -add SAP710-PI1SCS_vmdg VMDg SAP710-PI1SCS

For more details on creating and modifying resource attributes for NIC, IP,
Lanman, VMDg andMountV refer to Cluster Server Bundled Agents Reference
Guide.

5 Create links between the resources.

C:\> hares -link SAP710-PI1SCS_ip SAP710-PI1SCS_nic

C:\> hares -link SAP710-PI1SCS_lanman SAP710-PI1SCS_ip

C:\> hares -link SAP710-PI1SCS_mnt SAP710-PI1SCS_vmdg

6 Create SAPWebAS resource for applications based on SAP NetWeaver

C:\> hares -add SAP710-PI1SCS_scs SAPWebAS SAP710-PI1SCS

Based on the SAP instance you are clustering, modify the resource attributes.

See “Agent attributes for SAP Web Application Server” on page 48.

7 Create resource dependencies for SAPWebAS resource.

The SAPWebAS resource depends on the Lanman and MountV resources.

C:\> hares -link SAP710-PI1SCS_scs SAP710-PI1SCS_lanman

C:\> hares -link SAP710-PI1SCS_scs SAP710-PI1SCS_mnt
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8 Verify the final resource dependencies for SAP server group.

Group Parent Child

SAP710-PI1SCS SAP710-PI1SCS_scs SAP710-PI1SCS_lanman

SAP710-PI1SCS SAP710-PI1SCS_scs SAP710-PI1SCS_mnt

SAP710-PI1SCS SAP710-PI1SCS_ip SAP710-PI1SCS_nic

SAP710-PI1SCS SAP710-PI1SCS_lanman SAP710-PI1SCS_ip

SAP710-PI1SCS SAP710-PI1SCS_mnt SAP710-PI1SCS_vmdg

9 Save the cluster configuration.

C:\> haconf -dump -makero

Configuring the SAPWebAS preonline script
In a clustered environment, the SAP administrator installs and configures SAP
Enqueue and SAP Enqueue Replication Server. SAP Enqueue and Enqueue
Replication Server have the following requisites:

■ If an Enqueue server instance fails, the server must fail over to the node on
which the Enqueue Replication Server instance is running.

■ If the Enqueue Replication Server instance fails, the instance must fail over to
a node on which Enqueue Server is NOT running.

The SAPWebAS preonline script facilitates proper Enqueue server failover behavior.
The existing VCS preonline script calls the SAPWebAS preonline script.

The SAPWebAS preonline script performs the following tasks:

■ If the service group for which the script is running does not have an Enqueue
server or an Enqueue Replication Server resource, the script returns the control
to the VCS preonline script.

■ If the service group has an Enqueue server or Enqueue Replication Server
resource, the script determines the node on which the online operation can be
performed. The script also ensures that the online operation does not execute
the VCS preonline script again.

To accomplish this failover behavior, you must configure the VCS preonline script.

The VCS preonline trigger calls an external preonline trigger
utility—sapwebaspreonline.exe. The initiated preonline trigger performs the steps
necessary for correct failover behavior of the Enqueue servers. The
sapwebaspreonline.exe utility is located in the %VCS_HOME%\bin\SAPWebAS directory.
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To configure SAPWebAS preonline script

1 Go to the %VCS_HOME%\bin\Trigger directory.

2 Skip this step if the preonline file exists in this directory.

If the preonline file does not exist, copy the sample preonline trigger file from
the %VCS_HOME%\bin\Sample_Triggers directory to the
%VCS_HOME%\bin\Triggers directory, rename the file to preonline, and then
use this file.

61Configuring the service groups for SAP Web Application Server
Configuring the SAPWebAS preonline script



3 Add the following lines to the preonline file:

#--------------------------------------------------------------

# Start sapwebas preonline trigger.

#--------------------------------------------------------------

# Perl preonline.pl <system> <group> <whyonlining>

<systemwheregroupfaulted>

my $system = $ARGV[0];

my $group = $ARGV[1];

my $whyonlining = $ARGV[2];

my $systemwheregroupfaulted = undef;

my $sArgs = join(' ', @ARGV);

VCSAG_LOG_MSG("I", "Arguments [$sArgs]", 15041);

if(defined $ARGV[3]) {

$systemwheregroupfaulted = $ARGV[3];

}

my $SAPWebASPreOnlineTrigger = sprintf("%s\\bin\\SAPWebAS\\

sapwebaspreonline.exe", $vcs_home);

VCSAG_LOG_MSG("I",

"The trigger command is [$SAPPreOnlineTrigger]", 15041);

if(defined $systemwheregroupfaulted)

{

VCSAG_LOG_MSG("I", "The group is faulted on syetem =

[$systemwheregroupfaulted]", 15042);

$CMD = sprintf("\"%s\" %s %s %s %s", $SAPWebASPreOnlineTrigger,

$system, $group, $whyonlining, $systemwheregroupfaulted);

}

else {

$CMD = sprintf("\"%s\" %s %s %s", $SAPWebASPreOnlineTrigger,

$system, $group, $whyonlining);

}

system($CMD);

my $exit_value = $? >> 8;

VCSAG_LOG_MSG("I", "The exit code from the trigger: [$exit_value].",

15046, $exit_value);

if($exit_value == 0) {

VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP executed

successfully.", 15046);

exit;

}

elsif($exit_value == 1) {

VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP FAILED.", 15047);

exit;
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}

else {

VCSAG_LOG_MSG("I", "Unknown PreOnline trigger.", 15048);

}

#--------------------------------------------------------------

# End sapwebas preonline trigger.

#--------------------------------------------------------------

.

.

# give control back to HAD.

if (defined $ARGV[3]) {

‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys $ARGV[0]

-checkpartial $ARGV[3]‘;

exit;

}

‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys $ARGV[0]‘;

exit;

4 Use the following command to set the preonline trigger attribute to true for the
Service Groups to which the Enqueue and Enqueue Replication server
instances belongs:

C:\> hagrp -modify service_group PreOnline 1 -sys system

The preonline script is now configured to facilitate Enqueue and Enqueue Replication
server behavior. You can view the logs in the VCS engine log, engine_A.log.

Note: Once the preonline trigger is configured, you may see unexpected behavior
while manually switching or performing online operations on the Enqueue Replication
service group. This behavior is a result of the control logic within the preonline
trigger that protects the Enqueue lock table. For system maintenance, if you prefer
to perform manual operations on the service groups, you can do so by disabling
the preonline trigger.

To disable the preonline trigger, use the following command:

C:\> hagrp -modify service_group PreOnline 0 -sys system
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Troubleshooting the agent
for SAP Web Application
Server

This chapter includes the following topics:

■ Using correct software and operating system versions

■ Meeting prerequisites

■ Configuring SAP Web Application Server resources

■ Starting the SAP Web Application Server outside a cluster

■ Troubleshooting common problems

■ Reviewing SAP Web Application Server agent log files

■ Reviewing error log files

■ Checks for an SAP Add-In Usage Types

Using correct software and operating system
versions

Ensure that no issues arise due to incorrect software and operating system versions.
For the correct versions of operating system and software to be installed on the
resource systems, refer to SORT site: https://sort.veritas.com/agents
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Meeting prerequisites
Before installing the Cluster Server agent for SAP Web Application Server, double
check that you meet the prerequisite requirements. For a list of prerequisites:

See “Before you install the agent for SAP Web Application Server” on page 42.

Configuring SAP Web Application Server
resources

Before using an SAP Web Application Server resource, ensure that you configure
the agent attributes correctly. For more information,

See “Agent attributes for SAP Web Application Server” on page 48.

Starting the SAP Web Application Server outside
a cluster

If you face problems while working with a resource, you must disable the resource
within the cluster framework. A disabled resource is not under the control of the
cluster framework, and so you can test the SAPWeb Application Server independent
of the cluster framework. Refer to the cluster documentation for information about
disabling a resource. You can then restart the SAPWeb Application Server outside
the cluster framework.

Note:Use the same parameters that the resource attributes define within the cluster
framework while restarting the resource outside the framework.

A sample procedure to start a SAP Web Application Server outside the cluster
framework, is illustrated as follows:

To start a SAP instance outside the cluster framework, using SAP MMC

1 Log in to the system as a sapsidadm user.

2 Use the SAPMicrosoft Management Console (MMC) to start the SAP instance.

Ensure that the SAP instance starts successfully. If the instance starts
successfully outside the cluster, you can attempt to start it inside the cluster
framework.
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To start a SAP instance outside the cluster framework, using the command
prompt

1 Log in to the system as a sapsidadm user.

2 Start the SAP Windows service SAPSAPSID_xx for SAP instance, using the
following command:.

drive\> net start SAPSAPSID_xx

3 Use the startsap.exe utility to start the SAP instance. Enter,

drive\>usr\sap\SAPSID\InstName\exe\startsap.exe name=SAPSID

nr=InstID sapdiahost=virtual_hostname

Ensure that the SAP instance starts successfully. If the instance starts
successfully outside the cluster, you can attempt to start it inside the cluster
framework.

Troubleshooting common problems
This section describes some problems that you may face while working with the
Cluster Server agent for SAP Web Application Server in a VCS environment.

Unable to install the Cluster Server agent for SAP Web Application
Server

If you are not able to install the Cluster Server agent for SAP Web Application
Server, check to see if previous versions of the agent are present in the system. If
present, remove the older agents and attempt to install the agent again.

Also, ensure that you go through the prerequisites before installing SAP NetWeaver.

See “Before you install the agent for SAP Web Application Server” on page 42.

Unable to see an entry in the SAP MMC for an SAP instance
If you cannot see any entry for an SAP instance in the SAP MMC, you must
re-register the SAP services as COM Typelibrary Only.
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To re-register the SAP services

1 At the command prompt, navigate to drive\Program Files\SAP\hostcntl\exe
directory.

2 Run the sapstartsrv.exe command.

3 In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field.

You must re-register the SAP services as described here whenever a change
in the SAP service registration occurs.

The agent for SAP Web Application Server fails to bring online an
SAP instance resource through VCS

Attempt to start the SAP resource outside the VCS environment to ensure that the
resource is working properly.

See “Starting the SAP Web Application Server outside a cluster” on page 65.

You can also view the log files to further diagnose the problem.

See “Reviewing SAP Web Application Server agent log files” on page 69.

SAP instance does not come online, and the startsap.exe command
exits with exit code -1

Check the SAP MMC to ensure that the entry for this SAP instance is present. If
the entry is not present, add the SAP instance in the SAP MMC.

See “Unable to see an entry in the SAP MMC for an SAP instance” on page 66.

Then attempt to bring the SAP instance online.

In case of an Enqueue server failure, the Enqueue server instance
fails to take over the lock table from the Enqueue Replication server
instance

If the Enqueue Replication server instance does not recognize the correct Enqueue
server instance, this problem may occur. Ensure that the value of InstID passed to
the Enqueue Replication server process, enrepserver.exe in the start profile, belongs
to the correct Enqueue server instance.
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The ensmon.exe command returns exit code 4 for a Enqueue server
instance

If the Enqueue Replication server is not configured or is not online, this problem
occurs. Ensure that if the Enqueue Replication server is configured, the instance
is online.

If the Enqueue Replication server instance is not configured, disable the replication
parameter in the Instance profile of the Enqueue server instance:

enque/server/replication = false

The return code of the ensmon.exe command is 8 for an Enqueue
Replication server instance

The return code indicates that the Enqueue server instance is down. When the
Enqueue server instance fails, the ensmon.exe command returns this code when
the instance is switching over to the Enqueue Replication server instance to take
over the instate lock table.

Check the state of the Enqueue server instance.

The Enqueue server instance does not fail over to the correct
Enqueue Replication server instance

This problem occurs if the preonline script is not configured properly. To configure
the preonline script:

See “Configuring the SAPWebAS preonline script” on page 60.

This problem also occurs if the InstType attribute is not set properly. Also make
sure that you configured EnqSrvResName attribute for Enqueue Replication Server
(ERS) Instance resource.

In case of a resource fault, the Service Group does not fail over
If the resource is not set to critical, the Service Group may not fail over. To resolve
the issue, set the resource to critical.
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Reviewing SAPWebApplication Server agent log
files

If you are facing problems while using the VCS agent for SAP Web Application
Server or an SAP server instance, refer to the following sections to access the
relevant files for information about the issue.

Using SAP instance log files
In case of problems while using the VCS agent for SAP Web Application Server,
you can access the SAP instance log files for more information. These log files are
located in the drive:\usr\sap\SAPSID\InstName\work directory.

Using SAP log files
If an SAP server is facing problems, you can access the agent log files to further
diagnose the problem. The log file is drive:\Program Files\Veritas\Cluster
Server\log\SAPWebAS_A.txt.

Reviewing error log files
If you face problems while using SAP NetWeaver instance or the agent for SAP
WebAS, use the log files described in this section to investigate the problems.

Using SAP NetWeaver instance files
If a SAP server is facing problems, you can access the server log files to further
diagnose the problem. The SAP log files are located in the
drive\usr\sap\SAPSID\InstName\work directory.

Reviewing cluster log files
In case of problems while using the agent for SAP Web Application Server, you
can access the engine log file for more information about a particular resource. The
engine log file is located at drive:\Program Files\Veritas\Cluster
Server\log\engine_A.txt.

Additionally, you can also refer to the latest SAP Web Application Server agent log
files located at drive:\Program Files\Veritas\Cluster Server\log\SAPWebAS_A.txt.
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Note: Include both these log files while addressing the problem to Veritas support
team.

Using trace level logging
The ResLogLevel attribute controls the level of logging that is written in a cluster
log file for each SAP Web AS resource. You can set this attribute to TRACE, which
enables very detailed and verbose logging.

If you set ResLogLevel to TRACE, a very high volume of messages are produced.
Veritas recommends that you localize the ResLogLevel attribute for a particular
resource.

Warning: You may consider to temporarily increase the timeout values for
SAPWebAS for debugging purposes. After the debugging process is complete, you
can revert back to the original timeout values.

To localize ResLogLevel attribute for a resource

1 Identify the resource for which you want to enable detailed logging.

2 Localize the ResLogLevel attribute for the identified resource:

hares -local Resource_Name ResLogLevel

3 Set the ResLogLevel attribute to TRACE for the identified resource:

hares -modify Resource_Name ResLogLevel TRACE -sys SysA

4 Note the time before you begin to operate the identified resource.

5 Test the identified resource. The function reproduces the problem that you are
attempting to diagnose.

6 Note the time when the problem is reproduced.

7 Set the ResLogLevel attribute back to INFO for the identified resource:

hares -modify Resource_Name ResLogLevel INFO -sys SysA

8 Review the contents of the log file. Use the time noted in Step 4 and Step 6 to
diagnose the problem.

You can also contact Veritas support for more help.

Checks for an SAP Add-In Usage Types
For an SAP Add-In system, you must perform the following checks before further
investigations:
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■ The SAP resources running the ABAP and Java Central Services instances are
in the same Service Group.

■ The SAP resources running the ABAP and Java Enqueue Replication server
instances, are in the same Service Group.

Note: Veritas recommends to configure the Central Services and Enqueue
Replication server instances for an Add-In usage type in different service groups
to minimize the SPOFs in a service group.

■ Ensure the following:

■ The EnqSrvResName attribute of the Java Enqueue Replication server
instance is set to the VCS resource that is running the corresponding Java
Central Services instance (SCS).

■ The EnqSrvResName attribute of the ABAP Enqueue Replication server
instance is set to the VCS resource that is running the corresponding ABAP
Central Services instance (ASCS).
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Sample Configurations
This appendix includes the following topics:

■ About the sample configuration for the agent for SAP Web Application Server

■ Sample agent type definition for SAP WebAS

■ Sample SAP resource configuration in a physical environment

■ Sample service group configuration for ABAP and Java Usage types

■ Sample service group configurations for SAP systems on Windows Server
2008/2012

■ Sample service group dependency for SAP Web Application Server

About the sample configuration for the agent for
SAP Web Application Server

The sample configuration depicts the resource types, resources, and resource
dependencies within the service group. Review these dependencies carefully before
configuring the agent for SAP Web Application Server. For more information about
these resource types, refer to theCluster Server Bundled Agents Reference Guide.

Sample agent type definition for SAP WebAS
This section provides the sample agent type definition for SAP WebAS.

type SAPWebAS (

static i18nstr ArgList[] = { ResLogLevel, SAPAdmin,

SAPAdminDomain, SAPAdminPassword, SAPHome, SAPHost,

SAPMonHome, SAPServiceUser, SAPSID, InstName,

InstProfile, InstType, ProcMon, EnqSrvResName,

AAppendix



MonitorProgram, SecondLevelMonitor}

str ResLogLevel = INFO

str SAPAdmin

str SAPAdminDomain

str SAPAdminPassword

str SAPHome

str SAPHost

str SAPMonHome

str SAPServiceUser

str SAPSID

str InstName

str InstProfile

str InstType = APPSERV

str ProcMon[]

str EnqSrvResName

str MonitorProgram

int SecondLevelMonitor = 0

)

Sample SAP resource configuration in a physical
environment

Given the number of possible SAP resource configurations, this section provides
sample working examples that configure a specific SAP instance for Add-In
installations.

Sample SAP primary application server instance
An excerpt of the main.cf file for a SAP primary application server instance is as
follows.

SAPWebAS SAP710-PI1PAS_sap (

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\DVEBMGS22\\exe"

SAPHost = sappi1pas

SAPMonHome = "E:\\usr\\sap\\rfcsdk\\bin"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = DVEBMGS22

InstType = APPSERV
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InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\

PI1_DVEBMGS22_sappi1pas"

ProcMon = { "disp+work.exe", "jstart.exe" }

)

Sample SAP additional application server instance
An excerpt of the main.cf file for a SAP additional application server instance is as
follows:

SAPWebAS SAP710-PI1PAS_sap (

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\D23\\exe"

SAPHost = sappi1aas

SAPMonHome = "E:\\usr\\sap\\rfcsdk\\bin"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = D23

InstType = APPSERV

InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\

SYS\\profile\\PI1_D23_sappi1aas"

ProcMon = { "disp+work.exe", "jstart.exe" }

)

Sample SAP Central Services instance
An excerpt of the main.cf file for an SAP Central Services instance is as follows.

SAPWebAS SAP710-PI1SCS_scs (

Critical = 0

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\ASCS20\\exe"

SAPHost = sappi1scs

SAPMonHome = "E:\\usr\\sap\\PI1\\ASCS20\\exe"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = ASCS20

InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\

PI1_ASCS20_sappi1scs"

InstType = ENQUEUE
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ProcMon = { "msg_server.exe", "enserver.exe" }

SecondLevelMonitor = 1

)

Sample SAP Enqueue Replication server instance
An excerpt of the main.cf file for a SAP Enqueue Replication server instance is as
follows.

SAPWebAS SAP710-PI1ERS_ers (

Critical = 0

SAPAdmin = pi1adm

SAPAdminDomain = SAP-DOMAIN

SAPAdminPassword = HVNtKVkRWnINjNKnL

SAPHome = "E:\\usr\\sap\\PI1\\ERS24\\exe"

SAPHost = sappi1ers

SAPMonHome = "E:\\usr\\sap\\PI1\\ERS24\\exe"

SAPServiceUser = SAPServicePI1

SAPSID = PI1

InstName = ERS24

InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\

PI1_ERS24_sappi1ers"

InstType = ENQREP

ProcMon = { "enrepserver.exe" }

EnqSrvResName = SAP710-PI1SCS_scs

SecondLevelMonitor = 1

)

Sample service group configuration for ABAP and
Java Usage types

The service group configuration in a cluster depends on some common
characteristics that must be part of the configuration design.

These characteristics include the following:

■ The SAP application server must be dependent on the database server

■ Each SAP instance (Application Server, Enqueue, and Enqueue Replication)
should have a separate virtual IP address assigned to facilitate network
transparency.

■ Each SAP instance (Application Server, Enqueue and Enqueue Replication)
should be placed on shared disk to facilitate cluster node transparency.
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■ Common file systems to include the profile, global and transaction file systems
should be managed from one or more shared disk objects. These systems must
be available to the SAP application via UNC path with SAPGLOBALHOST.

Figure A-1 shows the service group configuration for Application Server

Figure A-1 Service group configuration for Application Server
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Figure A-2 shows the service group configuration for SAP Central services instance
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Figure A-2 Service group configuration for SAP Central services instance
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Figure A-3 shows the service group configuration for Enqueue Replication Server
instance
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Figure A-3 Service group configuration for Enqueue Replication Server
instance
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Sample service group configurations for SAP
systems on Windows Server 2008/2012

This section provides the sample service group configurations and resource
dependency diagrams for SAP systems on Windows Server 2008/2012.

Sample configuration for SAP Central Services Instances service
group for Add-In installation Usage Type

This section provides the VCS main.cf for SAP Central Services Instances service
group for Add-In installation Usage Type.
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group SAP-PI3SCS (

SystemList = { SysA = 0, SysB = 1 }

)

FileShare SAP-PI3SCS_sapmnt_FS (

PathName = "\\usr\\sap"

ShareName = sapmnt

LanmanResName = SAP-PI3SCS_Lanman

MountResName = SAP-PI3SCS_H_MountV

UserPermissions = { "'SAP_LocalAdmin'" = FULL_CONTROL,

"'Administrators'" = FULL_CONTROL,

"'SYMCORP\\SAP_PI3_GlobalAdmin'" = FULL_CONTROL,

"'SAP_PI3_LocalAdmin'" = FULL_CONTROL }

)

IP SAP-PI3SCS_IP (

Address = "10.xxx.xx.30"

SubNetMask = "255.255.252.0"

MACAddress = "00-15-17-63-45-92"

)

Lanman SAP-PI3SCS_Lanman (

VirtualName = sappi3scs

IPResName = SAP-PI3SCS_IP

)

MountV SAP-PI3ASCS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\ASCS29"

VolumeName = PI3ASCS_vol

VMDGResName = SAP-PI3ASCS_VMDg

)

MountV SAP-PI3SCS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\SCS30"

VolumeName = PI3SCS_vol

VMDGResName = SAP-PI3SCS_VMDg

)

MountV SAP-PI3SCS_I_MountV (

MountPath = "I:"

VolumeName = PI3SCS_I_vol

VMDGResName = SAP-PI3SCS_I_VMDg

)

MountV SAP-PI3SYS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\SYS"

VolumeName = PI3SYS_vol

VMDGResName = SAP-PI3SYS_VMDg

)

NIC SAP-PI3SCS_NIC (
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MACAddress = "00-15-17-63-45-92"

)

SAPWebAS SAP-PI3ASCS_SAPWebAS (

SAPSID = PI3

SAPHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"

SAPMonHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"

SAPHost = sappi3scs

ProcMon = { "msg_server.exe", "enserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQUEUE

InstName = ASCS29

InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_ASCS29_sappi3scs"

)

SAPWebAS SAP-PI3SCS_SAPWebAS (

SAPSID = PI3

SAPHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"

SAPMonHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"

SAPHost = sappi3scs

ProcMon = { "msg_server.exe", "enserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQUEUE

InstName = SCS30

InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_SCS30_sappi3scs"

)

VMDg SAP-PI3SCS_I_VMDg (

DiskGroupName = PI3SCS_I_dg

)

VMDg SAP-PI3ASCS_VMDg (

DiskGroupName = PI3ASCS_dg

)

VMDg SAP-PI3SCS_VMDg (

DiskGroupName = PI3SCS_dg

)

VMDg SAP-PI3SYS_VMDg (

DiskGroupName = PI3SYS_dg

)

SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_Lanman
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SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_I_MountV

SAP-PI3SCS_IP requires SAP-PI3SCS_NIC

SAP-PI3SCS_Lanman requires SAP-PI3SCS_IP

SAP-PI3ASCS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3ASCS_MountV requires SAP-PI3ASCS_VMDg

SAP-PI3SCS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3SCS_MountV requires SAP-PI3SCS_VMDg

SAP-PI3SCS_I_MountV requires SAP-PI3SCS_I_VMDg

SAP-PI3SYS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3SYS_MountV requires SAP-PI3SYS_VMDg

SAP-PI3ASCS_SAPWebAS requires SAP-PI3SCS_sapmnt_FS

SAP-PI3ASCS_SAPWebAS requires SAP-PI3ASCS_MountV

SAP-PI3ASCS_SAPWebAS requires SAP-PI3SYS_MountV

SAP-PI3SCS_SAPWebAS requires SAP-PI3SCS_sapmnt_FS

SAP-PI3SCS_SAPWebAS requires SAP-PI3SCS_MountV

SAP-PI3SCS_SAPWebAS requires SAP-PI3SYS_MountV

// resource dependency tree

//

// group SAP-PI3SCS

// {

// SAPWebAS SAP-PI3ASCS_SAPWebAS

// {

// FileShare SAP-PI3SCS_sapmnt_FS

// {

// Lanman SAP-PI3SCS_Lanman

// {

// IP SAP-PI3SCS_IP

// {

// NIC SAP-PI3SCS_NIC

// }

// }

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// }

// MountV SAP-PI3ASCS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }
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// VMDg SAP-PI3ASCS_VMDg

// }

// MountV SAP-PI3SYS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// VMDg SAP-PI3SYS_VMDg

// }

// }

// SAPWebAS SAP-PI3SCS_SAPWebAS

// {

// FileShare SAP-PI3SCS_sapmnt_FS

// {

// Lanman SAP-PI3SCS_Lanman

// {

// IP SAP-PI3SCS_IP

// {

// NIC SAP-PI3SCS_NIC

// }

// }

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// }

// MountV SAP-PI3SCS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// VMDg SAP-PI3SCS_VMDg

// }

// MountV SAP-PI3SYS_MountV

// {

// MountV SAP-PI3SCS_I_MountV

// {

// VMDg SAP-PI3SCS_I_VMDg

// }

// VMDg SAP-PI3SYS_VMDg

// }
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// }

// }

Sample resource dependency for SAP Central Services Instances
service group for Add-In installation usage type

Figure A-4 shows the sample resource dependency diagram for SAP Central
Services Instances service group for Add-In installation Usage Type on a Windows
2008/2012 Server.
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Figure A-4 Sample resource dependency diagram for SAPCentral Services
Instances service group for Add-In installation Usage Type on a
Windows 2008/2012 Server
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Sample configuration for SAP Enqueue Replication Server Instances
service group for Add-In installation Usage Type

group SAP-PI3ERS (

SystemList = { SysA = 0, SysB = 1 }

)

IP SAP-PI3ERS_IP (
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Address = "10.xxx.xx.30"

SubNetMask = "255.255.252.0"

MACAddress = "00-15-17-63-45-92"

)

Lanman SAP-PI3ERS_Lanman (

VirtualName = sappi3ers

IPResName = SAP-PI3ERS_IP

)

MountV SAP-PI3AERS_MountV (

MountPath = "C:\\usr\\sap\\PI3\\ERS31"

VolumeName = PI3AERS_vol

VMDGResName = SAP-PI3AERS_VMDg

)

MountV SAP-PI3ERS_MountV (

MountPath = "C:\\usr\\sap\\PI3\\ERS32"

VolumeName = PI3ERS_vol

VMDGResName = SAP-PI3ERS_VMDg

)

NIC SAP-PI3ERS_NIC (

MACAddress = "00-15-17-63-45-92"

)

SAPWebAS SAP-PI3AERS_SAPWebAS (

SAPSID = PI3

SAPHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"

SAPMonHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"

SAPHost = sappi3ers

ProcMon = { "enrepserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQREP

InstName = ERS31

InstProfile = "\\\\sappi3scs\\sapmnt\\

PI3\\SYS\\profile\\PI3_ERS31_sappi3ers"

EnqSrvResName = SAP-PI3ASCS_SAPWebAS

)

SAPWebAS SAP-PI3ERS_SAPWebAS (

SAPSID = PI3

SAPHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"

SAPMonHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"

SAPHost = sappi3ers

ProcMon = { "enrepserver.exe" }
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SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQREP

InstName = ERS32

InstProfile = "\\\\sappi3scs\\sapmnt\\

PI3\\SYS\\profile\\PI3_ERS32_sappi3ers"

EnqSrvResName = SAP-PI3SCS_SAPWebAS

)

VMDg SAP-PI3AERS_VMDg (

DiskGroupName = PI3AERS_dg

)

VMDg SAP-PI3ERS_VMDg (

DiskGroupName = PI3ERS_dg

)

SAP-PI3ERS_IP requires SAP-PI3ERS_NIC

SAP-PI3ERS_Lanman requires SAP-PI3ERS_IP

SAP-PI3AERS_MountV requires SAP-PI3AERS_VMDg

SAP-PI3ERS_MountV requires SAP-PI3ERS_VMDg

SAP-PI3AERS_SAPWebAS requires SAP-PI3AERS_MountV

SAP-PI3AERS_SAPWebAS requires SAP-PI3ERS_Lanman

SAP-PI3ERS_SAPWebAS requires SAP-PI3ERS_MountV

SAP-PI3ERS_SAPWebAS requires SAP-PI3ERS_Lanman

// resource dependency tree

//

// group SAP-PI3ERS

// {

// SAPWebAS SAP-PI3AERS_SAPWebAS

// {

// MountV SAP-PI3AERS_MountV

// {

// VMDg SAP-PI3AERS_VMDg

// }

// Lanman SAP-PI3ERS_Lanman

// {

// IP SAP-PI3ERS_IP

// {

// NIC SAP-PI3ERS_NIC

// }

// }

// }
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// SAPWebAS SAP-PI3ERS_SAPWebAS

// {

// MountV SAP-PI3ERS_MountV

// {

// VMDg SAP-PI3ERS_VMDg

// }

// Lanman SAP-PI3ERS_Lanman

// {

// IP SAP-PI3ERS_IP

// {

// NIC SAP-PI3ERS_NIC

// }

// }

// }

// }

Sample resource dependency for SAP Enqueue Replication Server
Instances service group for Add-In installation Usage Type

Figure A-5 shows the sample resource group dependency for SAP Enqueue
Replication Server Instances service group for Add-In installation Usage Type
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Figure A-5 Sample resource group dependency for SAPEnqueueReplication
Server Instances service group for Add-In installation Usage Type
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Sample service group dependency for SAP Web
Application Server

This section includes service groups that show the group dependency for SAPWeb
Application Server.

Figure A-6 shows the sample service group dependency.
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Figure A-6 Sample service group dependency
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